Adobe Photoshop Tools and Keyboard Shortcuts

e The following chart offers a quick reference of Photoshop press Shift-M to toggle between the Rectangular and
O | tools, as well as the keyboard shortcut for each tool. Not Elliptical Marquee tools. You can change this behavior in the
i— | all nested tools can be accessed with a shortcut. In the General pane of the Preferences dialog box by unchecking
5‘ marquee tools, for example, the shortcut toggles between the Use Shift Key for Tool Switch option.
Z | the rectangular and elliptical variations only. ’
= Finally, if you press and hold a tool’s keyboard shortcut, you
9 Also, most nested tools have the same shortcut as the can temporarily call the appropriate tool (called spring-
0 | default tool. Photoshop groups related tools into nested loaded keys); after releasing the shortcut key, you return to
g sets, s0 the same shortcut is assigned to the nested the tool you were using previously. For example, you might
V2 | variations. By default, you have to press Shift plus the use this technique to switch temporarily from the Brush tool
.Q shortcut key to access the nested variations; for example, to the Eraser tool while painting.
e
A 1| B¢y Move tool (V) &, Brush tool (B) T, Horizontal Type tool (T)

/;‘ Pencil tool (B) lT‘ Vertical Type tool (T)

,.:] Rectangular Marquee tool (M) "

% Color Replacement tool (B) "’;__t_“ Horizontal Type Mask tool (T)

Elliptical Marquee tool (M
Q, £l 2 M) B Vertical Type Mask tool (T)

==2 Single Row Marquee tool é‘ Clone Stamp tool (S)
g , Single Column Marquee tool %‘ Pattern Stamp tool (S) L3 . Path Selection tool (A)
R . Direct Selection tool (A)
§. Lasso tool (L) S History Brush tool (Y)
v‘ Polygonal Lasso tool (L) ﬂ Art History Brush tool (Y) [#, Rectangle tool (U)
ﬁ‘ Magnetic Lasso tool (L) ,‘ Rounded Rectangle tool (U)

&7, Eraser tool (E)

@  Ellipse tool (U)

c

i} ick Selection tool (W Background Eraser toof (E
8, Quick Selection tool (W) 5, g (E) @) Polygon tool (U
Magic Wand tool (W Magic Eraser tool (E
g 20 W o, Mg & \, Line tool (U)
ﬁ‘ Crop tool (C) (@ Gradient tool (G) &’? Custom Shape tool {U)
X, Slice tool (C) &‘ Paint Bucket tool (G)

<& 3D Rotate tool (K)
& . Blur tool @, 3D Roll tool (K)

P slice Select tool (C)

A, Eyedropper tool () {\, Sharpen tool ap, 3D Pan tool (K)
¥ Color Sampler tool () . Smudge tool =g 3D Slide tool (K)
&2, Ruler tool () A 3D Scale tool (K)
- Dodge tool (O
3 Notes tool (I) % Dodge tool (0) :
y € Burn tool (O) S, 3D Orbit tool (N)
123 Count tool () “ :
c @ Sponge tool (O) d‘ 3D Roll View tool (N)
ﬁ Spot Healing Brush tool (J) ‘%-, 3D Pan View tool (N)
Pen tool (P : .
ﬁ Healing Brush tool (J) Q‘ SLLIoolE) o+ 3D Walk View tool (N)
! & Patch tool () Q\‘_ Freeform Pen tool (P) 9’.‘ 3D Zoom View tool (N)

Q‘: Add Anchor Point tool

Q“ Delete Anchor Point tool QP_. Hand tool (H)
& Rotate View tool (R)

‘U‘ Red Eye tool (J)

N, Convert Point tool

@ Zoom tool (2)
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Stage - Coloring and Painting Artwork

The CMYK color model, also called “process color,” recreates the range of printable colors by
overlapping layers of cyan, magenta, yellow, and black inks in varying percentages from 0-100.

Using theoretically pure pigments, a mixture of equal parts of cyan, magenta, and yellow would
produce black. Real pigments, however, are not pure; the actual result of mixing these three colors
usually appears as a muddy brown. The fourth color, black (K), is added to the three subtractive
primaries to extend the range of printable colors and allow much purer blacks to be printed than is
possible with only the three primaries. Black is abbreviated as “K” because it is the “key” color to
which others are aligned on the printing press. Using K for black also avoids confusion with blue in
the RGB color model.

In the following image, the left block is printed with 100% black ink. The right block is a
combination of 100% cyan, 100% magenta, and 100% yellow inks.

In process-color printing, the four process colors — cyan, magenta, yellow, and black
(CMYK) — are imaged (also referred to as separated) onto individual printing plates. Each color
separation is printed on a separate unit of a printing press. When printed on top of each other in
varying percentages, the semi-transparent inks produce the range of colors in the CMYK gamut.
Special (spot) colors are printed using specifically formulated inks as additional color separations.
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Different color models have different ranges or gamuts of possible colors. A normal human visual
system is capable of distinguishing approximately 16.7 million different colors; color reproduction
systems, however, are far more limited. The RGB model has the largest gamut of the output models.
The CMYK gamut is much more limited; many of the brightest and most saturated colors that can be
reproduced using light (in the RGB model) cannot be reproduced using CMYK inks.

RGB
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‘Understanding Col L i ol =
' Many vague and technical-sounding terms are mentioned when discussing color. Is hue the same as color? The same as

E

value? As tone? What's the difference between lightness and brightness? What is chroma? And where does saturation fit in?

This problem has resulted in several attempts to normalize color communication. A number of systems have been developed
to define color according to specific criteria, including Hue, Saturation, and Brightness (HSB); Hue, Saturation, and Lightness
(HSL); Hue, Saturation, and Value (HSV); and Lightness, Chroma, and Hue (LCH). Each of these models or systems plots color
on a three-dimensional diagram, based on the elements of human color perception — hue, colorfulness, and brightness.

Hue is what most people think of as color — red, green, Chroma is similar to saturation, but chroma factors in a
purple, and so on. Hue is defined according to a color’s reference white. In any viewing situation, colors appear
position on a color wheel, beginning from red (0°) and less vivid as the light source dims. The process of chromatic
traveling counterclockwise around the wheel. adaptation, however, allows the human visual system

to adjust to changes in light and still differentiate colors
according to the relative saturation.

Brightness is the amount of light reflected off an object.
As an element of color reproduction, brightness is typically
judged by comparing the color to the lightest nearby object
(such as an unprinted area of white paper).

Lightness is the amount of white or black added to the
pure color. Lightness (also called “luminance” or “value")
is the relative brightness based purely on the black-white
value of a color. A lightness value of 0 means there is no
addition of white or black. Lightness of +100 is pure white;
lightness of —100 is pure black.

Saturation (also called “intensity") refers to the color’s
difference from neutral gray. Highly saturated colors are
more vivid than those with low saturation. Saturation is
plotted from the center of the color wheel. Color at the
center is neutral gray and has a saturation value of 0; color
at the edge of the wheel is the most intense value of the
corresponding hue and has a saturation value of 100.

All hues are affected equally by changes in fightness.

If you bisect the color wheel with a straight line, the line
creates a saturation axis for two complementary colors. A
color is dulled by the introduction of its complement. Red,
for example, is neutralized by the addition of cyan (blue and
green). Near the center of the axis, the result is neutral gray.

-100 0 +100

Project 2: Balloon Festival Artwork =B




13. Select everything on the Artboard and drag all objects to the top-left corner
of the Artboard. Lock all layers.
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14. Save the file and continue to the next stage of the project.

Before you Jump mto the exercises in thls stage of the project, you should understand the terms that are commonly used
when people talk about type. Keep the following terms in mind as you work through the following exercises.

i

Serif font

Baseline | However enticing it is to wander
unchecked through a garden of bright
images, are we not enticing your. mind from

Leading { another subject of almost equal importance?

Sans-serif font I_,/ — Ernest Bramah,_The Story.of Hien
. PY .

- 1maginatl

| i o

Proportionally Selected text would Two characters around
spaced characters be affected by the insertion point
tracking adjustment would be affected by
kerning adjustment.

Ascender
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Descender

Type is typically divided into two basic categories: serifand  The x-height of type is the height of the lowercase letter
sans serif. Serif type has small flourishes on the ends of x. Elements that extend below the baseline are called
| the letterforms; sans-serif has no such decorations (sans descenders (as in g, j, and p); elements that extend above
! is French for “without"). There are other categories of the x-height are called ascenders (as in b, d, and k).
special or decorative fonts, including script, symbol, dingbat,

decorative, and image fonts. The size of type is usually measured in points (there are

approximately 72 points in an inch). When you define a type

The actual shape of letters is determined by the specific size, you determine the distance from the bottom of the
- font you use; each character in a font is referred to as descenders to the top of the ascenders (plus a small extra

a character or glyph. Fonts can be monospaced or space above the ascenders called the body clearance).
proportionally spaced. In a monospace font, each character
takes up the same amount of space on a line; in other
words, a lowercase i and m occupy the same horizontal
space. In a proportionally spaced font, different characters
occupy different amounts of horizontal space as necessary.

When you set type in a digital application, it rests on a
non-printing line called the baseline. If a type element has
more than one line in a single paragraph, the distance from
one baseline to the next is called leading (pronounced
"ledding”). Most applications set the default leading as
120% of the type size.

_‘ :vizl 6L6‘ Adobe [llustrator CS4
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The Choracte Panel

[ The Character panel,

ILLUSTRATOR FOUNDATIONS

| Window>Type>Character,

in De

accessed either from the

| Control panel hot text
| or as an independent

panel by choosing

Font Variation

Fequtar ™ Leading

Size

Kerning }—_ TEE A & EwE | _{ Tracking

includes all the options It these options are
not visible, choose

you can use to change the ¢, Options in the
appearance of selected text panel Options men.

Horizontal Scale |—f S B 9 ITEIE 19
Baseline Shift || T2]rz] ——

Underline

[ & B 19 mEp ml/{ Vertical Scale

L MEFe ) @ BF M+ Character Rotation
+—{ Strikethrough

Language

characters.

 Leading is the distance from one baseline to the
next. Adobe applications treat leading as a character
attribute, even though leading controls the space
between lines of an individual paragraph. (Space
between paragraphs is controlled using the Space
Before option in the Paragraph panel.) To change
leading for an entire paragraph, you must first select
the entire paragraph. This approach means you can
change the leading for a single line of a paragraph by
selecting any character(s) in that line; however, changing
the leading for any character in a line applies the same
change to the entire line that contains those characters.

¢ Kerning increases or decreases the space between

pairs of letters. Kerning is used in cases where particular
letters in specific fonts need to be manually spread
apart or brought together to eliminate a too-tight or
too-spread-out appearance. Manual kerning is usually
necessary in headlines or other large type elements.
(Many commercial fonts have built-in kerning pairs, so
you won't need to apply much hands-on intervention
with kerning. Adobe applications default to the kerning
values stored in the font metrics.)

¢ Tracking, also known as “range kerning,” refers
to the overall tightness or looseness across a range
of characters. Tracking and kerning are applied in
thousandths of an em (or the amount of space occupied
by an uppercase “M,” which is usually the widest
character in a typeface).

d

\’ Dictionary
Vertical Scale and Horizontal Scale artificially
stretch or contract the selected characters. This scaling
is a quick way of achieving condensed or expanded type
if those variations of a font don't exist. (Type that has
been artificially condensed or expanded too much looks
bad because the scaling destroys the type’s metrics; if
possible, use a condensed or expanded version a font
before resorting to horizontal or vertical scaling.)

Baseline Shift moves the selected type above or below
the baseline by a specific number of points. Positive
numbers move the characters up; negative values move
the characters down.

Character Rotation rotates only selected letters,
rather than rotating the entire type object.

Underline places a line below the selected characters.

Strikethrough places a line through the middle of
selected characters.

In addition to these options, several artificial type styles
(All Caps, Small Caps, Superscript, and Subscript)
can be applied using the panel Options menu.

Project 3: Identity Package Em;‘




14. Click OK to create the new file.

15. If you don't see rulers on the top and left edges, choose View>Rulers to e
toggle rulers on. + e P—
As we explained in the Interface chapter, the panels you see depend on what was done Remember: Panels can

the last time you (or someone else) used the Photoshop application. Because workspace | always be accessed in the

arrangement is such a personal preference, we tell you what panels you need to use but
we don't tell you where to put them.

| Window menu.
|

In our screen shots we typically float panels over the relevant area of the document; this
allows us to focus on the most important part of the file at any time. As you complete
the projects in this book, feel free to dock the panels, grouped or ungrouped, iconized or
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16.

expanded, however you prefer.
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Choose File>Save As.

Rulers display
the selected unit
| values.

As we mentioned earlier,
the document tab shows
the file name you already
defined. This makes it much
easier to work with multiple
files, rather than a long list
of Untitled1, Untitled2, etc.

Understanding Color Modes | | '

PHOTOSHOP FOUNDATIONS

The color mode (or color space) defines the structure of
the colors in your file.

Bitmap color reproduces all pixels in the image as either
black or white; there are no shades of gray.

Grayscale color reproduces all tones in the file as shades
of gray. This type of image has only one channel (you learn
about color channels later in this book).

RGB creates color by combining different intensities of red,
green, and blue light (collectively referred to as the “additive
primaries”). Computer monitors and television sets display
color in RGB, which has a gamut or range of more than
16.7 million different colors. An RGB file has three color
channels, one for each of the additive primaries.

CMYK (“process”) color is based on the absorption and
reflection of light. Four process inks — cyan, magenta,
yellow, and black (collectively referred to as the “subtractive
primaries”) — are used in varying combinations and
percentages to produce the range of printable colors in most
commercial printing. A CMYK file has four color channels,
one for each of the four subtractive primaries.

Theoretically, a mixture of equal parts of cyan, magenta,
and yellow would produce black. Pigments, however, are
not pure, so the result of mixing these colors is a muddy
brown (called hue error). To obtain vibrant colors (and so
elements such as type can be printed cleanly), black ink is
added to the three primaries. Black is represented by the
letter “K" for “key color.”

LAB color is device independent; the colors it describes
don't depend upon the characteristics of a particular printer,
monitor, or scanner. In theory, LAB bridges the gap between
the various color models and devices; it is used as the
background when converting images from one color space
to another.

The problem with using RGB for print jobs is that the RGB
colors eventually need to be converted to CMYK separations
for a commercial printing press. Photoshop includes
sophisticated tools that allow you to control this conversion,
which you'll learn about in Project 6. Since you're creating
this file for print, it's a better idea to create it in the color
mode that will ultimately be used — CMYK — so you won't
have to convert and correct colors later.

Project 4: Four-Color Movie Ad  [ZAKTS
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| extra information stored in the RAW format. Click the

Capturing Images from a Camera

The Get Photos from Camera button in Bridge (=) opens
the Photo Downloader dialog box, where you can pull
images from your digital camera, name them logically
(according to your instructions), and store them somewhere
on your hard drive or network.

ImiMcowres 18 subleiders] ([ Thaove. )
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Rename Files:
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O3 Presarve Currum Fikename in XMP

+ Advanced Options

[ Open Adobe Bridge
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Batch Renaming

If you choose Tools>Batch Rename in Bridge, you can change
the names of multiple files in a single action. For example, we
frequently use this command to add the appropriate codes to
screen captures (“_PSCS4_04" for images in Project 4 of our
Photoshop CS4 book). Rather than manually type this into

every file name, we use the Batch Rename function to add the
information for us. You have full control over what's used for the
new file names, including dates, locations, custom text, and more.

Curvent Silename  080_PSCS4_01Jpg
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Qe e | &=
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— New Filenamas
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Ehuuva <urrent Mename in XMP Metadata

Compatibibty: [ Windows [/ Mac 05 [ Unbx

New fllensme: 001 PSCS4_06 fpg
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Accessing the Metadata Placard

Bridge's Metadata Placard shows technical
photographic data, including virtual film speed,
shutter settings, and a host of other information
refative to images brought in from higher-end
digital cameras. You can toggle it on or off in the
Metadata panel Options menu. e

Video
" oiou
T uokile SAT

Find...

Increase Font Size
Decrease Font Size

Append Metadata
Replace Metadata

Managing Camera RAW-Formatted Files

Most professional photographers rely on cameras that
are a combination of digitaf and traditional SLR (single-
lens reflex) technology. The file format of these high-end
Cameras contains far more data than Photoshop was
originally designed to handle. To resolve this problem,
manufacturers developed the RAW format, which stores
more data — particularly in color ranges, hue, lighting,
density, and other specifications.

Both Bridge and Photoshop CS4 include the necessary
tools to open and work with RAW images, making fine
and detailed adjustments without losing any of the

Open in Camera Raw button in Bridge (©) to access
these options.

EAXAX XX XA XXX

Project 4: Four-Color Movie Ad w
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Each segment has two anchor points and two
associated handles. We first clicked to create Point
A and dragged (without releasing the mouse
button) to create Handle A1. We then dlicked and

PHOTOSHOP FOUNDATIONS

Anchor Point and Handle Review |

As you learned in Project 2, an anchor point marks the end of a line segment, and the point handles determine the
shape of that segment. The Pen tool (and its variants) in Photoshap function in essentially the same manner as the same
tools in Illustrator. (The Photoshop Help files refer to handles as direction lines, and distinguishes different types of points
with different names. Our aim here is to explain the overall concept of vector paths, so we use the generic industry-standard
terms. For more information on Adobe's terminology, refer to the Photoshop CS4 Help files.)

Point A |

dragged to create Point B and Handle B1; Handle ~ Handle A1

B2 is automatically created as a reflection of B1 \"l Handle B2

(Point B is a symmetrical point).

This image shows the result of dragging Handle I Fie

B1 to the left instead of to the right. Notice the ,_’,___' gy e

difference in the curve here, as compared to the to the right.
| curve above. By dragging the handle, the segment  Dragging the

arcs away from the direction of the handle. handleczj <|iofwn ’\

and left...

It's important to understand that a segment is
connected to two handles. In this example, Handle
A1 and Handle A2 determine the shape of Segment
A. Dragging either handle to the right pulls out the
arc of the connected segment.

Handle A1 }/

Segment A
Handle A2

Clicking and dragging a point creates a symmetrical
point; both handles start out at equal length,
directly opposite one another. Dragging one handle
of a symmetrical point also changes the opposing
handle of that point. (In the example here, dragging
Handle B also moves Handle A, which affects the
shape of Segment A.)

\ Handle A

Segment A / / Handle B

You can create corner points by simply clicking
with the Pen tool instead of clicking and dragging.
Corner points do not have their own handles; the
| connected segments are controlled by the handles
of the other associated points.

Handle of other connected point
controls the segment shape.

k\{ Corner point has no handles.

You can convert a symmetrical point into a corner
point by clicking the point with the Convert Point
tool [ M.] (nested under the Pen tool). You can also
add a handle to only one side of an anchor paint by
Option/Alt-clicking a point with the Convert Point
tool and dragging.

Option/Alt-click this point with
the Convert Point tool and
drag to create only one handle.

—

This handle controls the
connected segment; the handle
is not reflected on the other
side of the point.

2
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8. In the Save As field, replace the word “copy” with 8118 to distinguish it

from the larger version.

Save As:lMuvle Ad 8x10.tif I@
EE! Pi] 182 |a11|m} !EUbenyAd ﬂ fQ search
i “Date Modified
' Macinto. £ Movie Ad.psd Today, 11:13 AM
8 ioak % | B Movie Ad.uf Today, 1:40 PM
& Phor.. 2 L
4
¥ PLACES v
Format: fTIFF-— e R
Save: MaAsa Copy ] Notes
Alpha Channels i1 Spot Colors
A Clayers
Color: Use Proof Setup: Working CMYK

[_}Embed Color Profile: U.S. Web Coated (SWOP) ...

‘A e must be saved 25 a copy with this selection.

9. Click Save. In the resulting TIFF Options dialog box, make sure the None
compression option is selected and the Byte Order is set to IBM PC.

10. Click OK to save the second version of the file.

11. When the save is complete, choose File>Close. Click Don’t Save when asked.

When you finished the previous exercise, you saved the ad as an 8.5 x 11” layered TIFF;
that TIFF file remained open at the end of the exercise (not the original PSD file). In
this exercise, you used the options in the Save As dialog box to save another copy of the

TIFEF file, this one with layers flattened and a small file size.

The open file is still the original Movie Ad.tif file, which you saved for the 8.5 x 11"
trim requirement. You've made changes, though (you cropped the image), so Photoshop
asks if you want to save your changes before closing. If you click Save, you will overwrite

the 8.5 x 11” version with the cropped version.

Save changes to the Adobe Photoshop document “Moavie
Ad.tif” before closing?

Common File Formats

.PHOTOSHOP FOUNDATIONS

Photoshop, with the extension PSD, is the native format.

Photoshop EPS can maintain vector and raster information
in the same file, and can maintain spot color channels.

JPEG is a lossy compressed file format that does not

| support transparency.

Large Document Format, using the extension PSB, is
used for images larger than 2 GB (the limit for PSD files):
this format supports all Photoshop features including
transparency and layers.

Photoshop PDF can contain all required font and image
information in a single file, which can be compressed to

{ reduce file size.

Photoshop 2.0 saves a flattened file that can be opened in
Photoshop 2.0; all layer information is discarded.

Photoshop Raw supports CMYK, RGB, and grayscale
images with alpha channels, and multichannel and LAB
images without alpha channels; this format does not
support layers.

Scitex CT is used for high-end image processing on
proprietary Scitex computers. (Although rarely used today,
this format is still used occasionally, so we include it here.)

TIFF is a raster-based image format that supports layers,
alpha channels, and file compression.

Photoshop DCS 1.0 creates a separate file for each color
channel in a CMYK image, plus a fifth composite file that
can be used for placement.

Photoshop DCS 2.0 is a later variation of DCS 1.0; version
2 supports spot color channels, and can be saved as multiple
files (one for each channel) or as a single file.

Project 4: Four-Color Movie Ad



The Undo command (Edit>Undo or Command/
Control-2) only steps back to the last one
action you completed; after you use the Undo
command, it toggles to Redo. You can also

use the Step Backward command (Edit>Step
Backward or Command-Option-Z/Control-Alt-Z)
to move back in the history one step at a time,
or use the History panel (Window>History) to
navigate back to earlier stages of your work.

Every action you take is recorded as a state in
the History panel. You can click any state to
return to that particular point in the document
progression. You can also delete specific states
or create a new document from a particular state
using the buttons at the bottom of the panel.

PHOTOSHOP FOUNDATIONS

By default, the History panel stores the last 20
states; older states are automatically deleted.

| You can change that setting in the Performance
pane of the Preferences dialog box. Keep in
mind, however, that storing a larger number of
states will increase the memory that is required
to work with a specific file.

Keep the following in mind when using the
History panel:

¢ The default snapshot shows the image state

when it was first opened.

The oldest state is at the top of the list; the
most recent state appears at the bottom.
The History State slider identifies the active
state.

You can save any particular state as a
snapshot to prevent it from being deleted
when that state is no longer within the
number of states that can be stored.

The history is only stored as long as the file
is open; when you close a file, the history
{including snapshots) is not saved.

When you select a specific state, the states

Selecting a state and then changing the image
eliminates all states that come after it.

History Optlons

Navigating the Photoshop History

Snapshot thumbnails “\-,_r

Individual history states ["

Create new document
from current state

|

Source for the History Brush )/ i / SR

History State inder’f : i /{ Delete current state

[Comaca | Performance
imeetace — Memory Usage - History & Cache -
Pre Handing ]‘ Available RAM: 1963 MB History States: = ——
Pertaemance A rey
p— Ideal Range: 1079-1413 M8 Cache Levels EE —
Teansparency & Camin Let Photoshop Use: MB (70% |
Uz & Ruders [ 1 }
| Gubdes. nd & Shces S & g R,
| eaces | — Scratch Disks — CPU Settings —
Tree [ A Torrwe TTrmetpace |information Detected Video Card.
[fIr ] @ wxewmshwo 2170503 A“Tm“mmuz‘;:m
i Al Opencl
A]| | engiee
v
| g Enable OpenCL Drawing
i | Advanced Settings...
| — D § ;

Color Picker: | Adobe
[[Bicublc (best for smooth gradients) -

| Image

— Options
) Auto-Update Open Documents & Animated Zoom
[T} Beep When Dane ] 2oom Resizes Windows

@] Dynamic Color Sliders
# Export Clipboard
B Use Shift Key for Tool Switch

[] Zoom with Scroll Wheel
[[] Zoom Clicked Point to Center
] Enable Flick Panning

below it are dimmed so you can see which changes will
be discarded if you go back to a particular history state.

Deleting a state deletes that state and those that came
after it. If you choose Allow Non-Linear History in the
History Options dialog box (accessed in the History panel
options menu), deleting a state deletes only that state.

Orexie

(O Both

Edit Log Items: [bSusions Only E

/'!5 History Log “
) l Save Log Items To: &) Metadata

If you need to keep a record of a file's history even after
you close the file, you can activate the History Log option in
the General pane of the Preferences dialog box. When this
option is checked, you can save the history log as metadata,
in a text file, or both. You can also determine the level of
detail that will be recorded in the history log.

Sessions Only records each time you launch or quit and
each time you open and close individual files.

Concise adds the text that appears in the History panel

o ically Create First

] Create New When Saving -
-Cancel
[} Allow Non-Linear History

["1Show New Snapshot Dialog by Default
[} Make Layer Visibility Changes Undoable

to the Sessions information.

Detailed gives you a complete history of all changes
made to files.

Adobe Photoshop CS4




More On Resolution and Resorhplihg _
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Every raster image has a defined, specific resolution that

is established when the image is created. If you scan an
image to be 3” high by 5” wide at 150 ppi, that image

has 450 pixels in each vertical column and 750 pixels in
each horizontal row. Simply resizing the image stretches or
compresses those pixels into a different physical space,
but does not add or remove pixel information. If you resize
the 3 x 5” image to 6 x 10” (200% of the original), the
450 pixels in each column are forced to extend across 6”
instead of 3, causing a marked loss of quality.

The effective resolution of an image is the resolution
calculated after any scaling is taken into account. This
number is equally — and sometimes more — important
than the original image resolution. The effective resolution
can be calculated with a fairly simple equation:

QOriginal resolution / (% magnification / 100} =
Effective resolution

If a 300-ppi image is magnified 150%, the effective
resolution is:

300 ppi / 1.5 = 200 ppi

In other words, the more you enlarge a raster image, the
lower its effective resolution becomes. In general, you can
make an image 10% or 15% larger without significant
adverse effects; the more you enlarge an image, however,
the worse the results. Even Photoshop, which offers very
sophisticated formulas (called “algorithms”) for sizing
images, cannot guarantee perfect results.

Downsizing

You can take advantage of effective resolution if you want to
print a low-resolution image that is a large enough physical
size. Consumer-level digital cameras work on this principle.

The camera captures all images at a set resolution (usually
72 ppi). The different quality settings (high, medium, and
low, or some similar variations) do not change the capturing
resolution. Instead, they affect the physical size of the
resulting image; “high” quality settings produce very large

| pictures, while “low” settings produce small pictures.

| When you first open a “high” quality picture in Photoshop,

you might have a picture that is 28” wide at 72 ppi. If you
resize the image to 25%, or 7” wide, you will increase the
effective resolution to 288 ppi — enough for most printing
applications.

Resampling

In general, you should always scan your images to the size

you will use in your final job. If you absolutely must resize

a digital image, you can use resampling to achieve better

results than simply changing the image size. Photoshop €54

offers five types of resampling algorithms to generate extra

pixel data (when increasing the image size) or to determine

which pixels to discard (when reducing the image size).
AT

N-ea.rls-( ngh.bm (preserve hard edges)

Bifinear

¥ Bicubic (best for smooth gradients)
Bicubic her (best for (]

RA@

Bicubic Sharper (best for reduction)

e Nearest Neighbor is a low-quality but quick
resampling method. Nearest neighbor interpolates new
pixel information based on only one of the squares in
the grid, usually resulting in an image with a blocky
appearance.

e Bilinear is a medium-quality resampling method.
Bilinear resampling averages adjacent pixels to create
new information.

¢ Bicubic creates the most accurate pixel information
for continuous-tone images; it also takes the longest
to process and produces a softer image. To understand
how this option works, think of a square bisected
both horizontally and vertically — bicubic resampling
averages the value of all four of those squares (pixels)
to interpolate the new information.

* Bicubic Smoother is useful for enlarging images with
smoother results than basic bicubic resampling.

* Bicubic Sharper is useful for reducing the size of an
image and maintaining sharp detail.

Discarding Pixels

Higher resolution means larger file sizes, which translates to
longer processing time for printing or longer download time
over the Internet. When you scale an image to a smaller size,
simply resizing can produce files with far greater effective
resolution than you need. Resampling allows you to reduce
the physical size of an image without increasing the
resolution, resulting in a smaller file size.

The caveat here is that once you discard (delete) pixels, they
are gone. If you later try to re-enlarge the smaller image,
you will not achieve the same quality as the original (before
it was reduced). You should always save reduced images as
copies instead of overwriting the original.
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Understanding Channels

PHOTOSHOP FOUNDATIONS

You need a bit of background about channels to understand what's happening in the Quick Mask you're using.

Every image has one channel for each
component color. An RGB image has three
channels: Red, Green, and Blue; a CMYK
image has four channels: Cyan, Magenta,
Yellow, and Black. Each channel contains
the information for the amount of that
component color in any given pixel.

channels, one for each
additive primary.

In RGB images, the three additive primaries
can have a value of 0 (none of that

color) to 255 (full intensity of that color).
Combining a value of 255 for each primary
results in white; a value of 0 for each primary
results in black.

A CMYK image has four
channels, one for each
subtractive primary plus
one for black.

In CMYK images, the three subtractive primaries
plus black are combined in percentages from 0 (none of that color) to 100 (full intensity of that color) to create the range of
printable colors. Channels in a CMYK image represent the printing plates or separations required to output the job.

When you work in Quick Mask mode, an extra Alpha channel is created to temporarily store the selection area. An Alpha
channel functions similar to a reqular channel, in that it has the same range of possible values as a regular color channel
(0-255 in an RGB image, 0~100 in a CMYK image). However, the Alpha value determines the degree of transparency in a
color. In other words, a 50% value
in the Alpha channel means that
area of the image will be 50%
transparent (semi-opaque). The Quick Mask channel
stores the degree of
transparency based on
the current selection.

Alpha channels allow you

to design with degrees of
transparency. You can blend one
image into another, blend one

layer into another, or blend an
entire image into a background

in a page-layout application (both
Adobe InDesign and QuarkXPress
support embedded Alpha channels).

The semi-transparent
red overlay shows
areas being masked
(i.e., the areas outside |
the current selection).

Change the mask to overlay the masked

— Color Indicates: ——— === area instead of the selected area.
You can change the appearance of masks by [ © Masked Areas

i : | ecte. s | -Cam:el o
double-clicking the Quick Mask button in the [@zaemied by Click here to change the color of

Tools panel, or double-clicking the Quick Mask [ = 7‘ the mask in the image window.
thumbnail in the Channels panel. L. Opachy: E“\ Use this option to make the mask more or

A . less transparent. This setting only affects
Quick Masks are useful when you need to work P J of.

: : ) . the appearance of the mask in Photoshop;
with a temporary selection or if you are still it doesn't change the transparency values
defining the exact selection area. As long as in the actual Alpha channel.

you stay in Quick Mask mode, the temporary

Alpha channel remains in the Channels panel (listed in italics as
“Quick Mask"). If you return to Standard mode, the Quick Mask
disappears from the window and the panel.

Once you've created a complex selection, you can save it as a
permanent Alpha channel by dragging the Quick Mask channel
onto the New Channel button at the bottom of the Channels
panel. Doing so adds a channel named " Quick Mask copy” (not in
italics), which will be a permanent part of the file even if you exit
Quick Mask mode.

Permanent Alpha channel
Temporary Quick Mask channel

New Channel button

1 -rvv-vv-v-vvvvvvwvvvt.O.".OI.O.UO......C.
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The Stylize Filters

In addition to the options in the Filter Gallery, other artistic filters can also be found
in the various Filter submenus. The Stylize filters (Filter>Stylize) generate artistic
effects, typically referred to as painted or impressionist.

Keep the following points in mind when you use filters;

* Filters can be applied to the entire selected layer or to an active selection.

* Some filters work only on RGB images; if you are in a different color mode, some
or all filter options — including the Filter Gallery — will be unavailable.

* Allfilters can be applied to 8-bit images; available filter options are limited for
16-bit and 32-bit images.

* Ifyou don't have enough available RAM to process a filter effect, you might get
an error message.

.

| . R
‘ [ Emboss makes an image look like Extrude creates a 3D texture of raised

‘ it was pushed out from (embossed) blocks or pyramids, using a defined or
| ‘ or into (debossed) the surface. random depth for the resulting grid.

l ‘ Find Edges identifies areas with Glowing Edges identifies color Solarize blends a negative and a
} ‘ significant transitions and emphasizes edges and adds a neon-like glow. positive image version of the image.
‘ ’ the edges with dark lines.

| ‘ Tiles splits an image into a grid, Trace Contour finds the transitions Wind adds tiny horizontal lines in the
and then offsets the resulting tiles with of major brightness areas and thinly image to create a windblown effect.
‘ your choice of “grout” or gap fill. outlines them for each color channel.

1 UTWWWWUWUUWW‘UU‘O"“l‘llllll‘t“‘-.
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The Distortion Filters | _ %

Filters can be used for a variety of purposes, from purely aesthetic to technically functional.
You can apply filters to specific selections, individual layers, or even individual channels
depending on what you need to accomplish. If you combine filters with Smart Objects, you
can also apply nondestructive filters and then change the settings or turn off the filter to
experiment with different results.

The Distortion filters let you squeeze, stretch, bend, twist, and otherwise distort an image
or selection. Some of these filters are controlled in the Filter Gallery, while others have their
own dialog boxes.

PHOTOSHOP FOUNDATIONS

Diffuse Glow adds a haze of Displace distorts an image Glass simulates the effect of Ocean Ripple simulates an
the current background color to  based on a displacement map looking through different underwater effect by adding
lighter regions of the image. (the tone values of which types of glass. randomly spaced ripples.

determine the distortion).

Pinch creates the effect of Polar Coordinates creates Ripple distorts the image. Shear distorts the image
squeezing the edges of the the effect of wrapping the You can only define the as if it were being reflected
image into a cylinder. amount and size of the effect. on an angled mirror.

Spherize simulates the effect Twirl simulates the Waves creates a rippled effect ZigZag distorts pixels
of wrapping an image around a effect of placing the image with control over wavelength,  diagonally, out from the center,
three-dimensional sphere. into a whirlpool. amplitude, and wave type. or around the center.
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7. Move the mouse cursor over an edge in the document window. Click to

change the preview area of the dialog box.

When you see the edges, you can see the effect of the diffusion. (If the layer had more
than just flat color, youd see the effect right away.) The diffused pixels allow the shape
edges to blend into the background instead of ending at an abrupt, sharp edge.

| When the Diffuse dialog box is
open, clicking in the image
changes the visible area in
preview window.

Preview

Mode

@ Normat

() Darken Only
) Lighten Only
€ Anisotropic

8. Leave the mode set to Normal and click OK.

9. Save the file and continue to the next stage of the project.

Lens Correction
The Lens Correction filter (Filter>Distort>Lens Correction) is designed to remove inherent distortion from an image. You

PHOTOSHOP FOUNDATIONS

can also rotate an image or fix perspective problems caused by a tilted camera.

Remove Distortion corrects lens barrel or pincushion
distortion. The slider straightens horizontal and vertical
lines that bend either away from or toward the center of
the image. (You can also use the Remove Distortion tool to
make this type of correction.)

The Chromatic Aberration options clean up flaws such
as color fringes or streaks around edges, as well as light-
related problems caused by the lighting of the lens.

Remove

Note:

Distortion tool
Straighten tool
Move Grid tool

D NTE:]

e, (G i) -m

[ Chromatic Absrration

Normal diffusion

| scaters pixels randomly.

Darken Only
replaces light pixels

with dark ones.

Lighten Only
replaces dark pixels
with light ones.

Anisotropic scatters
pixels where there is the
least difference in color.

The Vignettes options correct dark edges caused by lens
faults or shading when the photograph was taken.

The Transform options correct out-of-perspective images
caused by camera tilt. The Vertical slider controls vertical
lines and the Horizontal slider controls horizontal lines. The
Angle option rotates the image to a specific degree.

The Edge options determine what will fill the empty areas
that result when you remove distortion.

Remave Distordon

+14.00
n

Fix Red/Cyan Fringe ]
——————

Fix Blva/Yeliow Fringe )
e e

(~— Vignette

Amaunt °
D C—
darken lighten

Midpeint +50
Sy m——

( Set Lens Deflul(’b)

a

[— Transform

o

Vertical Perspective

Horizamtal Perspective [CH
D e i

A Preview snnm; w168 C-IH:-_@

ngle: @ 000 |*
. (e ——)
Scale oo
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Distinguishing Photoshop Blénding' Modes

When working with blending modes, think of the top layer as the “blend” layer and the next lowest layer as the “base”.

Normal is the default mode (no blending applied).

Dissolve results in a random scattering of pixels of
both the blend and base colors.

Darken returns the darker of the blend or base color.
Base pixels that are lighter than the blend color are
replaced; base pixels that are darker than the blend
color remain unchanged.

Multiply multiplies (hence the name) the base color by
the blend color, resulting in a darker color. Multiplying
any color with black produces black; multiplying any
color with white leaves the color unchanged (think of
math — any number times 0 equals 0).

Color Burn darkens the base color by increasing the
contrast. Blend colors darker than 50% significantly
darken the base color by increasing saturation and
reducing brightness; blending with white has no effect.

Linear Burn darkens the base color similar to Color
Burn; using Linear Burn, the brightness is reduced about
twice as much for blend colors in the mid-tone range.

Darker Color compares the channel values of the
blend and base colors, resulting in the lower value.

Lighten returns whichever is the lighter color (base or
blend). Base pixels that are darker than the blend color
are replaced; base pixels that are lighter than the blend
color remain unchanged.

Screen is basically the inverse of Multiply, always
returning a lighter color. Screening with black has no
effect; screening with white produces white.

Color Dodge brightens the base color. Blend colors
lighter than 50% significantly increase brightness;
blending with black has no effect.

Linear Dodge (Add) is similar to Color Dodge,
but creates smoother transitions from areas of high
brightness to areas of low brightness.

Lighter Color compares channel values of the blend
and base colors, resulting in the higher value.

Overlay multiplies or screens the blend color to
preserve the original lightness or darkness of the base.

Soft Light darkens or lightens base colors depending
on the blend color. Blend colors lighter than 50% lighten
the base color (as if dodged); blend colors darker than
50% darken the base color (as if burned).

e Hard Light combines the Multiply and Screen modes.
Blend colors darker than 50% are multiplied, and blend
colors lighter than 50% are screened.

* Vivid Light combines the Color Dodge and Color Burn
modes. Blend colors lighter than 50% lighten the base
by decreasing contrast; biend colors darker than 50%
darken the base by increasing contrast.

® Linear Light combines the Linear Dodge and Linear
Burn modes. If the blend color is lighter than 50%, the
result is lightened by increasing the base brightness.
If the blend color is darker than 50%, the result is
darkened by decreasing the base brightness.

* Pin Light preserves the brightest and darkest areas of
the blend color; blend colors in the mid-tone range have
little (if any) effect.

¢ Hard Mix pushes all pixels in the resulting blend to
either all or nothing. The base and blend values of each
pixel in each channel are added together (e.g., R 45
[blend] + R 230 [base] = R 275). Pixels with totals over
255 are shown at 255; pixels with a total lower than
255 are dropped to 0.

 Difference inverts base color values according to the
brightness value in the blend layer. Lower brightness
values in the blend layer have less of an effect on the
result; blending with black has no effect.

® Exclusion is very similar to Difference, except that
mid-tone values in the base color are completely
desaturated.

®  Hue results in a color with the luminance and saturation
of the base color and the hue of the blend color.

e Saturation results in a color with the luminance and
hue of the base color and the saturation of the blend
color.

e Color results in a color with the luminance of the base
color and the hue and saturation of the blend color,

* Luminosity results in a color with the hue and
saturation of the base color and the luminance of the
blend color (basically the opposite of the Color mode).

When using a painting tool (Brush, Paint Bucket, Pencil,
etc.), you have two additional blending mode options:

¢ Behind paints only on the transparent pait of a layer.
* Clear paints each pixel and makes it transparent.

Adobe Photoshop CS4
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Liquify Filter Tools

Several tools in the Liquify dialog box distort the brush area
when you drag. The distortion is concentrated at the center
of the brush area, and the effect intensifies as you hold
down the mouse button or repeatedly drag over an area.
Some of the tools (Twirl, Pucker, Bloat, and Turbulence) have
airbrush-like effects, applying more distortion when you hold
down the mouse button for a longer period of time.

Use the following as a guide when you want to create
unique effects with the Liquify filter:

* The Forward Warp tool pushes pixels in the direction
you drag.

* The Reconstruct tool restores distorted pixels to their
original state.

* The Twirl Clockwise tool rotates pixels clockwise as
you hold down the mouse button or drag. Press Option/
Alt to twirl pixels counterclockwise when you hold down
the mouse button or drag.

* The Pucker tool moves pixels toward the center of the
brush, creating a zoomed-out effect if you simply hold
down the mouse button without dragging.

* The Bloat tool moves pixels away from the center of
the brush, creating a zoomed-in effect if you simply hold
down the mouse button without dragging.

Forward Warp tool ]~——
H— Reconstruct tool
Twirl Clockwise too! |—H®
€ H— Pucker tool
Bloat tool —H&
#&H— Push Left tool
Mirror tool F—H#R

— Turbulence
Freeze Mask
| Thaw Mask
Hand tool —H

FCRR

—{ Zoom tool

* The Push Left tool moves pixels left when you drag
up, and moves pixels right when you drag down. You
can also drag clockwise around an object to increase its
size, or drag counterclockwise to decrease its size. Press
Option/Alt to reverse the direction of the distortion.

The Mirror tool copies pixels to the brush area. Drag
to mirror the area perpendicular to the direction of
the stroke. Press Option/Alt to mirror the area in the
direction opposite to that of the stroke.

* The Turbulence tool scrambles pixels.

* The Freeze Mask tool protects areas where you paint
from being liquified.

e The Thaw Mask tool removes the protection created
by the Freeze Mask tool.

* The Hand and Zoom tools have the same function
here as in the main Photoshop interface.

Using Masks

By freezing areas of the Liquify Filter preview, you protect
those areas from distortion with a mask that looks and
behaves like Quick Mask mode in the main Photoshop
interface. You can use the Mask options to freeze areas
based on existing selections, transparent areas, or layer
masks in the original image. Each button has a pop-up
menu, where you can choose one of those options (if they
are available):

* Replace Selection creates a new mask from the
selection, transparency, or mask.

* Add to Selection adds the selection, transparency, or
mask to the currently thawed area.

* Subtract from Selection adds the selection,
transparency, or mask to the currently frozen area.

| Replace Selection

Add to Selection

{ Subtract from Selection

Intersect with Selection

3--—| Invert Selection

| Click to reverse the current mask
Click to mask the entire image
Click to unfreeze all masked areas

* Intersect with Selection creates a mask with any
areas that are frozen in the preview and in the selection,
transparency, or mask from the original image.

* Invert Selection inverts the mask in the preview
image within the boundaries of the selection,
transparency, or mask from the original image.

srsuuuuuuuuuluuulﬂﬂ‘tﬂmm
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The Blur Filters

The Filter>Blur menu includes a number of choices for applying
corrective or artistic biurs to an image or selection.

Average finds the average color of an image or selection,
and then fills the image or selection with the color to create a
smooth appearance.

e B 5

Blur and Blur More smooth transitions by averaging the piXels | uus e woes |
next to the hard edges of defined lines and shaded areas. When e

ERRCEEE

you apply these filters, you have no additional control: Blur is : 2%
roughly equivalent to a 0.3-pixel radius biur, and Blur More uses
approximately a 0.7-pixel radius.

PHOTOSHOP FOUNDATIONS

Box Blur averages the color value of neighboring pixels. You can
adjust the size of the area used to calculate the average value; a
larger radius value results in more blurring.

e e

Gaussian Blur blurs the selection by a specific amount. pedea o 5

Mation Blur includes an option for changing the blur angle, as
well as a Distance value for the number of pixels to blur.

Radial Blur either spins the pixel around the center point of
the image, or zooms the pixel around a center point based on
the Amount setting. The farther the pixel is from the adjustable
center point, the more the pixel is blurred. You can drag the Blur
Center window to move the center point of the blur.

el AL c]

moele | (5
| Shape Blur uses a specific shape (kernel) to create the blur. ' Ditance: B pnel
You can load different shape libraries by clicking the triangle and
choosing from the list. Radius determines the size of the kernel; e A
the larger the kernel, the greater the blur. e " .
e Gl
Smart Blur allows you to blur tones closely related in value fotet et |
{ without affecting the edge quality of an image. You can set a [ Sz 3 ‘
radius for blurring, just as you can with the Gaussian Blur filter. oot hes
The Threshold setting allows you to determine how closely pixels Ocem

must be related in tone before being blurred (from 0.01t0 100). |~~~

You can also specify a Quality level (High,
Medium, or Low) or change the Mode setting.
Using the Edge Only mode, edges are outlined
in white, and the image is forced to black.
Using the Overlay Edges mode, the color image
is blurred, and the edges are outlined in white.

Surface Blur blurs an image while trying to
preserve edges. The Radius option specifies
the size of the blur in whole numbers. The
Threshold option controls how much the tonal
values of neighboring pixels must differ before
being blurred. (You can only apply whole-
number radius blurs.)

Lens Blur adds blur to an image to create the
effect of a narrower depth of field so sorme
objects in the image remain in focus, while
others areas are blurred.

Radius: 16| pixels
[~ ma T T [ Y °
ALY A-g o
G| ||/ HO®IH W]
| [ OL©®™ 4 = ¥

Z]G Fe-9¥ic]
Radius:[S | pixels
L ———

Threshold: (1S | lewels
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The Smart Sharpen Filter ,
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| regions for highlights.

The Smart Sharpen filter allows you to independently control the amount of sharpening that occurs in shadow and highlight
areas. The Sharpen tab defines how much sharpening will be applied.

Amount and Radius have the same purpose
as in the Unsharp Mask filter. A higher Amount
increases contrast between edge pixels; a higher
Radius value widens the effects applied to edges.

g Preview
© basic @ Advanced

TR0

Remove defines the sharpening algorithm used
to sharpen the image. Gaussian Blur is the method
used by the Unsharp Mask filter. Lens Blur detects
edges and detail in an image, and provides finer

detail and fewer halos. Motion Blur tries to reduce "“““"_ e I
the effects of blur due to movement. e .:

|
Angle sets the direction of motion if you choose age [T |

|

the Remove Motion Blur option.

[ More Accurate

The More Accurate check box processes the file ‘
more slowly for a more accurate blur removal.

Using the Shadow and Highlight tabs, you can adjust sharpening [ Sextings: [Defauk T2} {B]Q)] setwngs: [Defaukt — — F}-(BY[ 6

of dark and light areas. (If you don't see these tabs, make sure the , i
Advanced radio button is selected.) Prefmeun 81X | | e Ameuncl ¥
Fade Amount adjusts the amount of sharpening. e | e«

Radius:[8 | pixets | Radius:[1T | pixels
Tonal Width controls the range of tones in the shadows or = | &
highlights that are being modified. Smaller values restrict the 5
adjustments to only darker regions for shadows and only lighter

Radius defines the size of the area (in pixels) around each pixel
used to determine whether a pixel is in the shadows or highlights.
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The Noise Filters

a bell-shaped curve. Monochromatic too much from surrounding pixels with
adds random pixels without affecting

the colors in the image.

prm— the median prightness value of the
compared pixels.

G Preview

2 | Noise is defined as random pixels that stand out from the surrounding pixels, either hurting the overall appearance of the
O | image (as in the case of visible grains in an old photograph) or helping to prevent printing problems (as in the case of a
E gradient that extends across a large area). Photoshop includes several filters (Filters>Noise) that can add or remove noise.
QO
= | The Add Noise filter applies random  The Dust & Scratches filter reduces  The Median filter reduces noise by
8 pixels to the image. Uniform distributes  noise by comparing the contrast of blending the brightness of pixels within
t | color values of noise between O pixels within the defined radius; pixels  a selection. The filter compares the
% and the defined amount. Gaussian outside the defined threshold are brightness of pixels within the defined
T | distributes color values of noise along adjusted. radius, and replaces pixels that differ
V4]
O

| O
T
[a

Ol =)
-
([ Cancel 1}

EPrevlm

B inomiti@m
Radius: |8 | pixels
£

Threshold: (9 fevels
o

S]

[ G 00k &
Amaount: % Radius: IL—-___] pixels
A e e Osem——
© Uniform [
© Caussian

Monochromatic

The final option for reducing noise is the Reduce Noise filter, which provides far greater control over different aspects of
the noise correction. In Basic mode, you can remove luminance noise and color noise in the composite image. In Advanced
mode, you can remove noise from individual color channels. (Luminance noise, also called grayscale noise, makes an
image appear grainy; color noise usually appears as color artifacts in the image.)

e Strength controls the amount of luminance noise reduction.

' o Preserve Details controls how carefully the filter compares the difference in luminance between adjacent pixels. Lower
values remove more noise but result in less detail.

e Reduce Color Noise removes random color pixels from the image.

o Sharpen Details sharpens the image. Because the noise reduction process inherently blurs the image, this option
applies the same kind of sharpening that is available in the Photoshop Sharpen filters.

e Remove JPEG Artifacts removes artifacts and halos caused by saving an image with a low JPEG quality setting (in
other words, using a high lossy compression scheme).

© preview (D Basic @ Advanced
@ Basic ) Advanced

e

Setting:

s: [ Default - F'a' EJ -

T Ouneel g Al )

Settings: | Default — 9 B8

Strength: |6
— s

Preserve Details: |60 %
—— e

Reduce Color Noise: |45 %
e

Sharpen Details: {25 % =
o Channel: | Red _a
Strength: [p
[

Remove JPEC Artifact
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4. Click the Warning icon in the upper-right corner of the panel to reset

the cache.

Every time you zoom in or out of an image, Photoshop stores the results of the display
in a cache (a drive location that keeps track of what youre doing). The image you're
looking at on the Histogram often doesn't match the results on the drive. The Warning
icon shows there’s a problem; clicking the icon resets the image and rereads the cache.

Note:

If you see the Warning
icon in the Histogram
panel, click the icon to
match the disk cache
with whats happening in

the live image.

Clicking the Warning icon
resets the cache.

Histogram Statistics

PHOTOSHOP FOUNDATIONS

The histogram shows the distribution of pixels — or
more accurately the tonal values of those pixels — from
the darkest to the lightest portions of an image, for

the entire image or for individual color channels. The
Histogram panel can help identify problems that need to
be corrected, while also showing you the overall effect of
a potential correction you might be considering.

In Expanded view, you can see more information about
how pixels are distributed in the image {from shadows on
the left to midtones in the center to highlights on the right).

¢ The Mean value is an average point of the brightness
values. A Mean of 128 usually identifies a well-balanced
image. Images with a Mean of 170 to 255 are light;
images with a Mean lower than 90 are very dark. (As
you can see, the image you're working with in this
exercise is relatively dark — a Mean of 87.50.)

* The Standard Deviation (Std Dev) value represents
how widely the brightness values vary.

¢ The Median value shows the middle value in the range
of color values.

e The Pixels value displays the total number of pixels
used for the graphic displayed on the histogram.

| o The Level statistic displays the intensity level of the

pixels below the mouse cursor.

Expanded view of the

Histogram panel shows
detailed statistics about pixels
on all or individual channels.

Count is the same as pixels — but only for the area
below the cursor (the Pixels value shows the total
number for the histogram).

Values displayed as a Percentile represent the
percentage of pixels below or to the left of the cursor
location. Zero represents the left edge of the image and
100% is the right edge.

The Cache Level is determined by the Performance
preferences (Preferences>Performance) and is related to
the Cache Refresh icon (and Warning icon). The larger
your cache, the more you can do before the image and
the disk cache don’t match. On the other hand, a larger
cache requires more RAM for the application to run
smoothly.
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Identifying Shadows and Highlights

As you moved the Shadow and Highlight sliders in the

ATIONS

point of the image — the points at which pixels become
black or white. The goal is to find highlight and shadow
points that maintain detail. Choosing a point that has no
detail causes the area to turn totally white (highlight) or

it can be difficult to visually identify the black and white

previous exercise, you changed the black point and white

black (shadow) with no detail reproduced. In some images,

points in an image:; in these cases you can use the Levels
dialog box to help you find those areas,

If you press Option/Alt while dragging the Input Shadow
or Input Highlight slider, the image turns entirely white
or black (respectively). As you drag, the first pixels that
become visible are the darkest shadow and the lightest
highlight.

| Option/Alt clicking

Option/Alt dragging
the Input Shadow
slider turns the
entire image white.
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As you drag right,
the first pixels that
become visible in the

image are the darkest |\

shadows in the image. |

o !e;;;.:;',; e Ed- P
L —

Input Levels:

the Input Highlight
slider turns the
,| entire image black.

| As you drag left, the first
‘ pixels that become visible
represent the lightest

| highlight in the image.

These tiny specs might not

be noticeable unless you
look very carefully (and you

I have a dust-free monitor).

weset: (Contom ™ i G

|

|| ‘I e

Output Levels:

| | Once you have identified the highlight and shadow

| points in the image, select the White Point eyedropper
‘ and click the highlight, and then select the Black Point
! ‘ eyedropper and click the shadow to define those two
! | areas of the image.

= |
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Input Levels
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L Ars
M Preview
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W
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o mozas
m"!:_ (= Cancel )
[.::.,, L,Iv,,,. Sample in image to
‘ Foerm set black point
I Z ’ 4 Sample in image to
Bl free set white point
b ] [255 ] K
Sample in image to
Qutput Levels: :
: . ! set gray point
e B
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The Curve Display options
allow you to control what is
visible in the graph. {If you
can't see the Curve Display
options, click the button

to the left of the heading.)
The Show Amount Of radio
buttons reverse the input and
output tone scales. Light is
the default setting for RGB
images; Pigment/Ink % is
the default setting for CMYK
images.
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Channel: [RGB — %] - sy 71

.2 Ed

Input_ T
' 255 ] 2 # # [showClipping

[] curve Display Options
Shaw Amount of: @ Light (0-25%) =
O Pamentiink %

Show: [ Channel Overlays B Baseline

Y
|
|
|

& Wistogram  Intersection Une

BT

AV

el Overlays [ Baseline
& ersection Line

[} s
w mlsesO
[=] curve Display Options —

Show Amaunt of (I Ught (0-255) -
@ Pigment/ink X, —-m

| Show- B Channel Overlays B
| i Histogram Bintersection Uine |

The On-Image adjustment tool lets
you click and/or drag directly on
an image to determine where the
point should appear on the curve.
You can add 14 points on a curve,
and delete points by pressing
Command/Control-delete.

Click this button to show or
hide the Curve Display options. | L

Gridlines in the graph can
help you more precisely
position curve points.

Use these buttons to
show a four-by-four grid
or a ten-by-ten grid.

When the Histogram
option is turned off, the
graph does not show the

| representative histogram.

When the Intersection Line
| option is active, crosshairs

appear when you drag a
point in the graph, which

can help you more precisely

adjust curve points.

Channel lﬁ Q

Curve Display Options | | %

L

'y
tnput:

N
Curve Display Options —
y Amount of: @ Ught (0-255) e
) Pigment/ink %
Show: B Channel Overlays 8 Baseline

@ Histogram

 Cramet (15818

. Ed

OQutput:

“Input:
rs’
[] curve Display Options —
Show Amount of- - O Light (0-255)
& Pigment/lak %

Show- [ Channel Overtays B Raseline
& Histogram & tntersection Line

[ Show Clipping

-~ Channel: [ C8 ~ 18]

| Show: EChannel Overtays [ Basellne [
& Histogram & imersection Line |

Channel: [ RGS — B

oY ’Iﬁl&' 2 AP CishowClghng |
<) curve Disptay Options ————/~—

© Ught 0-255)" g
0 Pgment/id = )
Show: 8 Channel Overiays ¥ Raseline

[ Histogram Fintersectiontine |

Show Amount of:

/7. [showClipping

\ By default, the lightest
| point for an RGB image
: is in the top right.

The darkest point for
an RGB image is in
the bottom left.

Hintersecton tine |

By choosing Show Amount of
Pigment/ink %, the tone scales
are reversed. For this RGB
image, the lightest point moves
to the bottom left and darkest
point moves to the top right.

When the Channel Overlays
option is checked, each
channel is represented on

| the graph by a separate line.

| When the Baseline option

is active, the original
curve is represented by a
gray line.
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